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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG (“Siemens”). They are non-
binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 
Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 
By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  
The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with industrial security functions that support the secure 
operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 
Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  
For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity. 
  

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Introduction 

1.1 Overview  

With the help of SIMATIC S7-PLCSIM Advanced virtual controllers for the 
simulation of a S7-1500 or ET 200SP CPU are created and used for the 
comprehensive simulation of functions. This means that no real controllers are 
required to test a STEP 7 program. 

The virtual controllers can also be tested and validated in the context of a system 
or machine. The application programming interface (API) allows manipulation of 
the simulated process image and is used to connect the virtual controller to a 
virtual model of a machine or plant or to specially programmed high-level language 
applications. 

This makes it possible to connect the virtual controller to simulation software such 
as SIMIT or NX Mechatronics Concept Designer for extensive validation of the 
STEP 7 program. The following application example should make the first steps in 
the general handling of S7-PLCSIM Advanced easier for you. In addition, this 
application example offers the "SimTableApplication" application with which you 
can conveniently and independently monitor and control PLC variables on the 
virtual controller via a simulation table. 

Figure 1-1 

Virtual Controller

STEP 7

TIA Portal

SIM table

SimTableApplication

 

Advantages of the Application Example 

• Quick introduction to the use of S7-PLCSIM Advanced 

• Possibility of testing user programs with TIA Portal and S7-PLCSIM Advanced 

• Convenient testing of user programs using simulation tables and S7-PLCSIM 
Advanced 

Delimitation 

• This application example complements the S7-PLCSIM Advanced manual. 
Detailed information can be found in the corresponding manual. 

• This application example requires basic knowledge of TIA Portal project 
planning. 
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1.2 How it works 

S7-PLCSIM Advanced supports the simulation of the following CPU families from 
firmware version V1.8: 

• S7-1500 (C, T, F) 

• ET 200SP 

• ET 200SP F 

In contrast to PLCSIM, S7-PLCSIM Advanced can be installed independently of 
TIA Portal and with its full Ethernet adapter "PLCSIM Virtual Ethernet Adapter" 
offers extended communication paths even beyond computer limits. 

 

1.2.1 Overview communication paths 

Table 1-1 

Communication paths Local Local Distributed 

Protocol Softbus TCP/IP TCP/IP 

Communication interface in S7-
PLCSIM Advanced 

PLCSIM PLCSIM Virtual 
Ethernet Adapter 

PLCSIM Virtual 
Ethernet Adapter 

STEP 7 and instances On a PC/ a VM On a PC/ a VM Distributed 

Communication...    

... between STEP 7 and instances Yes Yes Yes 

…between instances Yes Yes Yes 

...via OPC UA server and web server No Yes Yes 

...between an instance and a real 
hardware CPU 

No No Yes 

...between an instance and a real HMI 
V14 or higher 

No No Yes 

...between an instance and a simulated 
HMI V14 or higher 

Yes Yes Yes 
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1.2.2 Local Communication 

Via softbus 

S7-PLCSIM Advanced enables you to communicate locally with the virtual 
controller via the "PLCSIM" softbus. All participants involved in the communication 
must be on the same PC / the same VM. 

Figure 1-2 

PC / VM

STEP 7

PLCSIM Softbus

PLCSIM Advanced

Virt. SIMATIC 

Memory Card

Runtime 

Instance 1

 

Via TCP/IP 

With S7-PLCSIM Advanced you can also communicate locally via TCP/IP protocol. 
S7-PLCSIM Advanced provides the PLCSIM Virtual Ethernet Adapter for this 
purpose. All participants involved in the communication must be on the same PC / 
the same VM. 

In this configuration it is possible to use TCP/IP functions of the virtual controller, 
such as communication via OPC UA and web server. Details can be found at 
Table 1-1 

Figure 1-3 

PC / VM

STEP 7

PLCSIM Virtual Ethernet Adapter

PLCSIM Advanced

Virt. SIMATIC 

Memory Card

Runtime 

Instance 1
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1.2.3 Distributed communication 

For distributed communication, i.e. across computer boundaries, S7-PLCSIM 
Advanced provides a PLCSIM Virtual Switch in addition to the PLCSIM Virtual 
Ethernet Adapter.  

The PLCSIM Virtual Switch is used to connect the PLCSIM Virtual Ethernet 
Adapter to a physical network card of your PC. This allows communication with the 
virtual controller from outside the PC. 

When using a VM, a bridged connection to a network card of the host computer 
must be set up. 

The following scenarios are possible: 

1. Communication between TIA Portal on the host machine and a virtual 
controller on the VM. 

2. Communication with a real CPU or a real HMI. The connection between real 
devices and the network card of the PC is made via an Ethernet cable. 

3. Communication with TIA Portal on another PC. The connection between the 
PCs is made with an Ethernet cable via the physical network cards. 

Scenarios 2 and 3 are also possible if S7-PLCSIM Advanced is installed directly on 
a PC. There is no need to configure a bridged connection, as this is only required 
for one VM. 

Figure 1-4 

PC 1
VM

PLCSIM Virtual Ethernet Adapter

Network card

Network card

Bridged Connection

STEP 7

STEP 7

Real CPU / 

Real HMI

Network card

PC 2

Ethernet TCP/IP

PLCSIM Virtual Switch

1

2 3

PLCSIM Advanced

Virt. SIMATIC 

Memory Card

Runtime 

Instance 1
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1.2.4 Virtual SIMATIC Memory Card 

S7-PLCSIM Advanced stores the user program, the hardware configuration and 
the remanent data of a loaded instance of a virtual controller in a virtual SIMATIC 
memory card. Each instance has a virtual SIMATIC memory card, which is created 
under a unique instance name of the virtual controller. 

If you use S7-PLCSIM Advanced to start a virtual controller with an instance name 
for which a virtual SIMATIC memory card already exists, the controller is started 
with the user program and hardware configuration contained in it. 

The storage location of the virtual SIMATIC Memory Card can be opened or 
changed via the control panel of S7-PLCSIM Advanced. 

For applications that interact with S7-PLCSIM Advanced via the API (user 
interface), the storage location can be defined on the application side. For 
example, the location of the virtual SIMATIC Memory Card for the 
"SimTableApplication" application is the same as the location of the simulation 
project. Thus the application always knows the access point to the data of the 
virtual controller. The "SimTableApplication" application is described in the chapter 
Application "SimTableApplication". 
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1.2.5 S7-PLCSIM Advanced Control Panel 

S7-PLCSIM Advanced provides a control panel for creating and operating 
instances of a virtual controller. If you use your own user programs (C++/C#), you 
do not need to use the integrated control panel, since its function can be mapped 
via the API. 

The Control Panel user interface is described below. 

Figure 1-5 Control panel 

1

2

3

4

7

8

9

10

11

5

6

 

Table 1-2: Control panel 

No. Function Description 

1.  Online access Selecting the communication interface 

- PLCSIM: Softbus, local 

- PLCSIM Virtual Eth. Adapter: TCP/IP, local or 
distributed 

2.  TCP/IP communication Selecting the network adapter for distributed 
communication 

- <Local>: local communication 

- <Network card>: Distributed communication 
via the set network card 

3.  Virtual time Slider for setting the scaling factor 

4.  Start Virtual S7-1500 PLC - Instance Name: Name of the instance; min. 3, 
max. 64 characters. 

- PLC type: Selection of the CPU type to be 
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No. Function Description 

simulated. 

- Start: Create and start the instance. 

 

Additionally, when selecting the PLCSIM Virtual Eth. 
Adapters: 

- IP address 

- Subnet mask 

- Standard gateway 

5.  Instance list The "RUN", "STOP" and "MRES" buttons for the 
operating mode and reset. 

The list shows the local instances of the CPUs. 

6.  LED displays The meaning of the LED is displayed when you move 
the mouse pointer over it. 

7.  Runtime Manager Port Opens a port on the local PC 

8.  Virtual SIMATIC Memory 
Card 

Opens the location of the virtual memory card. 

Click on the following symbol  to define the 
storage location. 

9.  Displaying messages Here you deactivate the S7-PLCSIM Advanced 
messages in the Windows task bar for the duration of 
operation. 

10.  Function Manual Here you open the function manual S7-PLCSIM 
Advanced in the standard PDF viewer. 

11.  Exit Exit switches off all instances and closes the control 
panel. 
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1.3 STEP 7 program 

This application example includes a TIA Portal example project with a STEP 7 
program. 

The STEP 7 program consists of a simple adding function in the cyclic OB 
"Main[OB1]. The addition is executed once if the variable "Global".executeAdd is 

set to TRUE. The result of adding the two variables "Global".summand1 and 

"Global".summand2 is assigned to the variable "Global".result. 

Fig. 1-6: STEP 7 program in cyclic OB 

 

The associated variables are declared in the global data block "Global[DB1]". 

Figure 1-7 Global data block "Global [DB1]" 

 

For monitoring and controlling variables in the online view of the controller, the 
observation table "WatchTableAddFunc" with the data block variables was inserted 
in the TIA Portal project. 

Figure 1-8 Watch table "WatchTableAddFunc" 
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1.4 Components used 

This application example was created with these hardware and software 
components:  

Table 1-3 

Components Number Article number Note 

STEP 7 Professional V15 1 6ES7822-1AE05-0YA5 - 

S7-PLCSIM Advanced V2.0 1 6ES7823-1FE01-0YA5 - 

 

Note In this application example no real hardware was used. All projected hardware 
components were simulated. 

 

This application example consists of the following components:  

Table 1-4 

Components File name 

Documentation 109759047_PLCSIMAdv_SimTable_DOC_V10_de.pdf 

TIA Portal sample project 109759047_PLCSIMAdv_SimTable_S7_PROJ.zip 

Application 
"SimTableApplication" 

109759047_PLCSIMAdv_SimTable_SIM_APPL.zip 

Visual Studio project 109759047_PLCSIMAdv_SimTable_CODE.zip 
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2 First steps with S7-PLCSIM Advanced 

2.1 Installation 

The setup program starts automatically with a double click on the download 
package or when you insert the DVD into the drive. Make sure that the following 
conditions are met before starting the installation process: 

• The computer's hardware and software meet the system requirements. 

• You have administrator rights on the installation computer. 

• No other programs are active. This also applies to the Siemens Automation 
License Manager and other Siemens applications. 

• All S7-PLCSIM versions less than or equal to V14 are uninstalled. 

2.2 Start S7-PLCSIM Advanced 

After installing S7-PLCSIM Advanced, the icon for S7-PLCSIM Advanced is located 
on the Windows desktop. To start S7-PLCSIM Advanced and open the Control 
Panel, follow these steps. 

1. Double-click the S7-PLCSIM Advanced icon on the Windows desktop. 

Figure 2-1 

 

2. After starting S7-PLCSIM Advanced the icon for S7-PLCSIM Advanced is 
displayed in the notification area of the task bar (next to the time and date). 
Tip: You can use Windows functions to permanently display the icon in the 
notification area of the taskbar. 

Figure 2-2 
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3. Right-click the icon in the task bar to open the S7-PLCSIM Advanced Control 
Panel. A click on a free area next to the control panel minimizes this again. 

Figure 2-3 

 

2.3 Creating an instance 

The following chapter shows how to create a new instance with S7-PLCSIM 
Advanced. 

Note If you use S7-PLCSIM Advanced to start a virtual controller with an instance 
name for which a virtual SIMATIC memory card already exists, the controller is 
started with the user program and hardware configuration contained in it. 

Use a new name for each new instance. 

 

2.3.1 Local Instance via Softbus 

1. Set the switch for "Online Access" to "PLCSIM". 

Figure 2-4 

 

2. Enter a name for your new instance, select the PLC type for your simulation 
and start the instance. 
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Figure 2-5 

 

After starting, the instance appears in the instance list with the default IP 
address "192.168.0.1" and in the stop state. 

Figure 2-6 

 

2.3.2 Local Instance via TCP/IP 

Note The switch for "Online Access" can only be activated after all started instances 
have been deactivated. 

 

1. Set the switch for "Online Access" to "PLCSIM Virtual Eth. Adapter". And leave 
the setting for the network card at "Local". 

Figure 2-7 

 

2. Enter a name for your instance, the IP address, and the subnet mask. Select 
the PLC type and start the instance. 
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Figure 2-8 

After starting, the instance appears in the instance list with the set IP address 
and in stop state. 

Figure 2-9 
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2.3.3 Distributed Instance over TCP/IP 

If no DHCP is available in your network, a static IP address must be assigned to 
the Siemens PLCSIM Virtual Ethernet Adapter for successful distributed 
communication. All IP addresses must be set so that they are all in the same 
subnet. 

The following figure shows an example of a possible setting of the IP addresses. 
These are addresses with the subnet mask "255.255.255.0". 

Figure 2-10 

PC

PLCSIM Virtual Ethernet Adapter

Network card

Real CPU / 

Real HMI

Ethernet TCP/IP

PLCSIM Virtual Switch

PLCSIM Advanced

Instance virtual 

Controller

IP: 192.168.0.10

IP: 192.168.0.101

IP: 192.168.0.102

IP: 192.168.0.2

 

Proceed as follows to set a static IP address for the Siemens PLCSIM Virtual 
Ethernet Adapter: 

1. In the Windows Control Panel, open the Network and Sharing Center. 

2. Select "Change adapter settings". 

Figure 2-11 

 

3. Open the properties of the Siemens PLCSIM Virtual Ethernet Adapter and 
open the properties of the "Internet Protocol Version 4 (TCP/IPv4)" element 
("Internet Protocol Version 4 (TCP/IPv4)"). 

4. Assign a free static IP address, which is located in the same subnet of your 
network and close the settings of the properties with "OK". 
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Figure 2-12 

 

 

The following describes how to create a distributed instance. 

Note The switch for "Online Access" can only be activated after all started instances 
have been deactivated. 

1. Set the switch for "Online Access" to "PLCSIM Virtual Eth. Adapter". Select the 
physical network card from the list via which the instance is to be accessible in 
the network. 

Figure 2-13 

 

2. The "Siemens PLCSIM Virtual Switch" is automatically activated for the 
selected network card in the properties of the interface. 
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Figure 2-14 

 

 

3. Enter a name for your instance, the IP address, and the subnet mask. Select 
the PLC type and start the instance. 

Figure 2-15 

After starting, the instance appears in the instance list with the set IP address 
and in stop state. 

Figure 2-16 
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2.4 Download from TIA Portal 

2.4.1 Activate simulability 

To use a STEP 7 project with the simulation, you must activate the simulability of 
blocks in the project properties. Follow these steps. 

1. Right-click on the project name of your TIA Portal project and select 
"Properties..." from the context menu. 

Figure 2-17 

 

2. Activate the property "Support simulation during block compilation" under 
"Protection". 

Figure 2-18 
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Note In order to use know-how-protected blocks or typed library blocks for the 
simulation, you must note the following: 

• Know-how-protected modules must be unlocked by entering a 
password. 

• Typed library blocks without activated simulability with S7-
PLCSIM Advanced must be in the "under test" state. 

Only then can the option "Simulability with SIMATIC S7-PLCSIM (Advanced)" 
("Can be simulated with SIMATIC S7-PLCSIM (Advanced)") be activated in the 
properties of the block in the "General > Translation" tab ("General > 
Compilation"). 

 

2.4.2 Load project to the virtual controller 

Requirement 

You can load the STEP 7 project to the virtual controller if the following conditions 
are met: 

• An instance of the virtual controller was created via the Control 
Panel or another application. 

• Simulability has been activated in TIA Portal. 

Select communication interface 

When loading the project to the virtual controller, you must select the PG/PC 
interface according to the communication interface of the virtual controller (see 
chapter 2.3 Creating an instance): 

• "PLCSIM" for download via Softbus 

• "Siemens PLCSIM Virtual Ethernet Adapter" for download via 
TCP/IP 

• For distributed communication, the real adapter connected to the 
network 

Display in Download Dialog 

The dialog in STEP 7 shows the compatible S7-PLCSIM Advanced instances the 
first time a CPU is downloaded. In the following example, an instance of the virtual 
controller was created using the "PLCSIM Virtual Ethernet Adapter" with the IP 
address 192.168.0.1. The configuration of a CPU 1511-1 PN with the configured IP 
address 192.168.0.10 is to be loaded to this instance. 

When searching for compatible instances via the "Siemens PLCSIM Virtual 
Ethernet Adapter" interface, the instance of the "S7-1500 (PLCSIM)" virtual 
controller is displayed, since no configuration has yet been loaded onto the 
controller. 
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Figure 2-19 

 

After loading on the instance of the virtual controller, it is configured. Then the 
instance appears in the download dialog as the loaded type of controller, in this 
case "CPU 1511-1 PN" with the IP address 192.168.0.10. 

Figure 2-20 

 

If the instance has been configured, then as many interfaces are visible as the 
CPU type, for example two PROFINET interfaces are displayed for a 1515-2 PN 
CPU. 
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2.5 Simulate example project 

Starting a virtual controller instance 

Since no special communication, such as communication via OPC UA, is required 
for this example, a local instance of the virtual controller via the "PLCSIM" softbus 
interface is sufficient. 

1. Start S7-PLCSIM Advanced and open the control panel. 

2. Leave the interface setting at "PLCSIM", enter a name for the instance and 
select "Unspecified CPU 1500" as PLC type. Then click "start". 

Figure 2-21 

 

The instance appears in the instance list with the configured name and IP 
address 192.168.0.1. The virtual controller instance is still in the "STOP" 
operating state, since no user program or configuration has yet been loaded 
onto the controller. 

Figure 2-22 

 



2 First steps with S7-PLCSIM Advanced 

 

Getting Started 
Entry ID: 109759047,    V1.0,    07/2018  24 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

8
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

3. Open the supplied TIA Portal project "MyProject". 

4. Mark the controller "PLC_1" and then click in the function bar on "Download to 
device". 

Figure 2-23 

 

5. The download dialog ("Extended Download to device") opens. Start the search 
for compatible devices via the PG/PC interface "PLCSIM". The instance of the 
virtual controller is displayed as "CPU-1500 Simulation". Select the device and 
start the charging process with ("Load"). 

Figure 2-24 
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6. Follow the download dialog and complete it by selecting the option "Start 
module" and clicking on "Finish". 

Figure 2-25 

 

7. Check the operating status of the virtual controller in the Control Panel. The 
controller must now be in "RUN" mode. 

Figure 2-26 

 

8. Open in TIA Portal in the project navigation under "MyProject > PLC_1 > 
Observation and force tables" ("MyProject > PLC_1 > Watch and force tables") 
the observation table "WatchTableAddFunc" and start the observation of the 
variables. 

Figure 2-27 
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9. Enter a tax value for each of the variables "Global".summand1, 
"Global".summand2 and "Global".executeAdd and click on the button for one-
time control of the variable. Observe the result of the add function in the 
variable "Global".result. 

Figure 2-28 
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3 Application "SimTableApplication" 

3.1 Overview 

With the simulation table tool for S7-PLCSIM Advanced you have the possibility to 
create a local instance of a virtual controller and load your STEP 7 program onto it 
from TIA Portal. You can then display variables used in the STEP 7 program in 
simulation tables and control and monitor them from there. 

Figure 3-1 

PLCSIM Advanced

SimTable-Tool

TIA Portal

1

2

3

Virtual controller 

instance

 

1. A local instance of a virtual controller is started via the control panel in the 
simulation table tool. 

2. The STEP 7 program is loaded into the virtual controller via the "PLCSIM" soft 
bus. 

3. The variables of the virtual controller can be observed and controlled in the 
simulation table. 
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3.2 How it works 

The application "SimTableApplication" uses the user interface (API) of S7-PLCSIM 
Advanced for the interaction with the virtual controller. 

The folder of the virtual SIMATIC Memory Card is created in the storage path of the 
simulation project. The virtual controller is operated via the control panel in the 
application. This means that the integrated S7-PLCSIM Advanced Control Panel is 
not required here. The runtime manager and runtime instance are started in the 
background as a Windows process. You can monitor the started processes in the 
Windows Task Manager under "Processes". 

After loading the STEP 7 program onto the virtual controller, the variables are 
exchanged between the virtual controller and the "SimTableApplication" application 
via the API. 

The following variables of the virtual controller can be accessed: 

• Input variables 

• Output variables 

• Variables from global data blocks 

• Markers 

 

The variables are updated at the cycle control point of the virtual controller. The 
control of selected variables is triggered by a button in the simulation table. 

3.3 User interface 

Figure 3-2 

1

2 3

 

1. Menu bar 
Shows menus for project commands and help commands. 

2. Project navigation 
Displays the project name, instance name and simulation tables. 

3. Working area 
Shows the window for operating the instance (Control Panel) and editing the 
simulation tables. 
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3.3.1 Menu bar 

Commands in the "Project" Menu 

Figure 3-3 

 

 

Table 3-1 

Menu text Description 

New ... Creates a new project. The currently open project must be closed first. 

Open... Selects an existing project to open. 

Close Closes the current project. If the current project contains unsaved changes, 
you will be prompted to save the project. 

Save Saves the project under the current path and file name with the file 
extension".sim". 

Save as... Saves your project under a new name and/or path. 

Exit Closes the simulated controller and application. If the current project 
contains unsaved changes, you will be prompted to save the project. 

Commands in the "Help" Menu 

Figure 3-4 

 

Under the menu text "About" you will find a link to the Siemens Industry website for 
online support, as well as details of the installed software. 
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3.3.2 Project navigation 

Figure 3-5 

1

2

3

4

 

1. Project folder, here with the name "MySimulation". 
With a right click on the project folder you can add a nine controller to the 
project or display the properties of the project. 

Figure 3-6 

 

2. If you have added a controller to your project, it will appear in the project folder, 
here with the name "MyInstance". By right-clicking or simply clicking on the 
controller, you can operate the controller via the context menu or the control 
panel in the workspace. 

Figure 3-7 

 

3. The "SIM tables" folder is created automatically as soon as a control is added. 
This folder contains all simulation tables of the corresponding controller. Right-
click on the folder to add a new simulation table. 

Figure 3-8 

 

4. The "Default Sim Table" simulation table is generated automatically and cannot 
be deleted. You can rename and/or delete all other simulation tables that you 
insert using the context menu of the relevant table. 
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3.3.3 Working area 

Controller 

If you select a controller in the project navigation, the corresponding control panel 
appears in the work area of the application. Here you can operate the virtual 
controller. 

Figure 3-9 
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1. With "Power On / Off Virtual Controller" you start the instance of the virtual 
controller. 

2. The LEDs are used to display the current status of the virtual controller and 
behave analog to the LEDs of a real controller. 

3. IP addresses of the virtual controller's ports. Depending on the loaded 
configuration of a controller, only one IP address (e.g. one CPU 1511-1 PN) or 
two IP addresses (e.g. one CPU 1515-2 PN) are displayed. 

4. Use the "RUN" button to set the controller to "RUN" mode. The changed status 
is indicated by the RUN LED. 

5. Use the "STOP" button to set the controller to "STOP" mode. The changed 
status is indicated by the STOP LED. 

6. Use the "MRES" button to reset the memory (Virtual Memory Card). The virtual 
controller is set to "STOP" mode. 

7. Use this button to display the location of the Virtual SIMATIC Memory Card of 
the corresponding instance in Windows Explorer. 



3 Application "SimTableApplication" 

 

Getting Started 
Entry ID: 109759047,    V1.0,    07/2018  32 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

8
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

SIM table 

Figure 3-10 

1
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4
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1. Search field for a specific variable on the virtual controller. The search is 
supported by listing the possible hits during the input. After selecting the 
appropriate search result, you can add the variable to the simulation table by 
pressing the Enter key or the plus symbol. 

2. With this button you control all selected variables (see point 10) in the 
simulation table once. 

3. This button allows you to add all project variables from the last STEP 7 load to 
the virtual controller in the simulation table. You can choose between the 
following variable memory areas: 

Figure 3-11 

 

• Inputs: Input variables declared in the PLC variables 

• Outputs: Output variables declared in the PLC variables 

• Memory bits: Flags declared in the PLC variables 

• Datablocks: Variables of all global data blocks 

4. With these buttons you can export the created simulation table in CSV format 
to Excel or import it from Excel. 

5. The names of the variables in a simulation table are displayed in the "Name" 
column. For variables of a data component, the variable also contains the 
name of the data component as a prefix. 

6. The "Datatype" column shows the data type of the variable. 

7. The "Area" column shows the memory area of the corresponding variable. 

8. The "Value" column contains the actual value of the variable (observed value). 

9. Input field for the control value of the variable. 

10. With these check boxes you select the variables which are to be controlled 
when the control button is pressed. 
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3.4 Create simulation project 

The following chapter describes how to simulate the supplied STEP 7 program with 
the "SimTableApplication" application and S7-PLCSIM Advanced and how to 
monitor and control the variables using a simulation table. 

It shows you how to create a new simulation project with the application. 
Alternatively, you can open the provided simulation project "MySimulation.sim" 
from the zipped folder "109759047_PLCSIMAdv_SimTable_SIM_PROJ.zip" and 
familiarize yourself with the project. 

 

1. Unpack the "109759047_PLCSIMAdv_SimTable_SIM_APPL.zip" folder 
supplied into any directory on your PC and start the "SimTableApplication.exe" 
application contained therein with a double-click. 

Figure 3-12 

 

2. Click on "Project > New..." in the menu bar to create a new project. 

Figure 3-13 

 

3. In the new "Create new Project" dialog box, enter a project name and select 
the location for the project. Optionally you can fill in the fields for version, 
author and comment. Then click “Create". 

Figure 3-14 
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4. Right-click on the project folder in the project navigation and select "Add new 
Controller" from the context menu to add a new virtual controller to the project. 

Figure 3-15 

 

5. In the new dialog window "Add New Controller" enter any controller name and 
select the controller type "S71500" for the simulation of an S7-1500 CPU. Then 
click “Add". 

Figure 3-16 

 

6. In the project navigation, select the added controller and start the virtual 
controller instance in the work area. The virtual controller initially starts with the 
"STOP" operating state, since no project has yet been loaded into the 
controller. 

Figure 3-17 
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7. Start the supplied project with TIA Portal "MyProject.ap15". 

8. Select the controller "PLC_1" in the project navigation and then click on 
"Download to device" in the function bar.  

Figure 3-18 

 

9. Follow the download dialog and load the project to the virtual controller via the 
"PLCSIM" softbus interface. 

10. Complete the download by selecting the option "Start module" and clicking on 
"Finish". 

Figure 3-19 

 

11. Return to the "SimTableApplication" application and check the operating state 
of the virtual controller, which must now be in "RUN" mode. 

Figure 3-20 
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12. Select the "Default SimTable" simulation table in the project navigation and 
click the "load all tags" button in the workspace. 

Figure 3-21 

 

13. Since only data block variables are used in the STEP 7 program, activate the 
checkbox for "Data blocks" in the new "Load all Project Tags" dialog window. 
This loads all data block variables from the loaded project into the simulation 
table. Then click “Load". 

Figure 3-22 

 

14. Enter a control value for each of the variables "Global.summand1", 
"Global.summand2" and "Global.executeAdd" and activate the corresponding 
checkbox for controlling the variable. 

Figure 3-23 

 

15. Click on the "modify all selected values" button and observe the result of the 
add function in the "Global.result" variable. 

Figure 3-24 
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16. Save the project so that you can use it again later. The loaded STEP 7 
program remains stored in the virtual SIMATIC Memory Card and can be used 
when the simulation project is opened again without reloading the controller. 

Figure 3-25 
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4 Appendix 

4.1 Service and Support  

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, application examples and videos 
– all information is accessible with just a few mouse clicks: 
https://support.industry.siemens.com 
 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers  
– ranging from basic support to individual support contracts. Please send queries 
to Technical Support via Web form: 
www.siemens.com/industry/supportrequest 
 

SITRAIN – Training for Industry  

We support you with our globally available training courses for industry with 
practical experience, innovative learning methods and a concept that’s tailored to 
the customer’s specific needs. 

For more information on our offered trainings and courses, as well as their 
locations and dates, refer to our web page: 
www.siemens.com/sitrain  
 

Service offer 

Our range of services includes the following:  

• Plant data services 

• Spare parts services 

• Repair services 

• On-site and maintenance services 

• Retrofitting and modernization services 

• Service programs and contracts 

You can find detailed information on our range of services in the service catalog 
web page: 
https://support.industry.siemens.com/cs/sc 
 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for Apple iOS, Android and Windows 
Phone:  
https://support.industry.siemens.com/cs/ww/en/sc/2067 

https://support.industry.siemens.com/
http://www.siemens.com/industry/supportrequest
http://www.siemens.com/sitrain
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067
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4.2 Links and Literature  

Table 4-1 

No. Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link to the article page of the application example  

https://support.industry.siemens.com/cs/ww/en/view/109759047 

\3\ Manual SIMATIC S7-1500 S7-PLCSIM Advanced 

https://support.industry.siemens.com/cs/ww/en/view/109739153 

\4\ In the manual "SIMATIC STEP 7 Basic/Professional V15 and SIMATIC WinCC 
V15": 

https://support.industry.siemens.com/cs/ww/en/view/109755202 

\5\ Digitalization with SIMATIC TIA Portal 

https://support.industry.siemens.com/cs/ww/en/view/109750456 

 

 

4.3 Change documentation 

Table 4-2 

Version Date Change 

V1.0 07/2018  First version 

   

 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/de/view/109759047
https://support.industry.siemens.com/cs/ww/en/view/109739153
https://support.industry.siemens.com/cs/ww/en/view/109755202
https://support.industry.siemens.com/cs/ww/en/view/109750456
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